# Table of Contents

## Installation Instructions
- System Requirements/Practice Management Integrations

## Installation Wizard

## Menu Options

## Functionality
- Languages
- Optional Practice Custom Backgrounds
- Web-Based Administration
- Protocols
- Videos and Forms
- Player Scrub Bar

## Getting Started
- Step 1: Patient Introduction Movie
- Step 2: Exported Records
- Step 3: Patient Case Presentation
- Step 4: Choosing Classification
- Step 5: Patient Problems
- Step 6: Treatment
- Step 7: Clinical Findings Reports
- Step 8: Selecting Patient Information and Care and Use Forms
- Step 9: Upload and Email

## Additional Functionality and Features
- Two-Phase Treatment
- Multiple Perspectives
- Multi-Function Appliances
- Multiple Treatment Options
- Multi-Step Treatment
- Blue Arrows
- New Patient
- Aesthetic Braces
- Braces Options
- Retention
- Dental Development
Installation Instructions

System Requirements
These guidelines must be followed to ensure that ScreenPlay works reliably and effectively on your computer. Older and slower equipment not meeting these specifications will not work.

Operating System
(Windows) XP, Vista, Windows 7
(Mac) OS 10.6 and Safari 5

Processor
(Windows) 2 GHz Intel Core 2 Duo or above recommended for smooth video playback
(Mac) 2 GHz Intel Core 2 Duo or above recommended for smooth video playback

System Memory
(Windows) 2 GB Recommended
(Mac) 2 GB Recommended

Video Card
(Windows) All basic video cards (PCI, ISA and AGP) support ScreenPlay
(Mac) 512 MB VRAM

Hard Drive
10.0 GB of space required. It is strongly recommended that the machine used for storing data (patient files, photos, etc.) be protected by an uninterruptible power supply (UPS).

Internet Connection
A high speed internet connection is required for updates, uploading (FTP), and emailing patient records.

Hardware Requirements
Desktop computer, monitor and mouse

Additional Hardware (Optional)
CD-RW/DVD-RW
Desktop PC Computer and Tablet
LED, LCD or Plasma Screen with Touch Sensitive Technology

Practice Management Integrations
The following integrations have been activated for ScreenPlay 8:

Carestream Dental/OrthoTrac
You must contact Carestream to activate the integration.

Ortho2
You must contact Ortho2 to activate the integration.

Oasys
The Oasys practice management system comes with the link to ScreenPlay already activated.

IMS
The IMS practice management system comes with the link to ScreenPlay already activated.

topsOrtho
This integration requires Mac OS 10.6.
Installation Wizard

Existing Users

For existing users, upgrading to 8.0, the wizard is similar in function to new installs. To access the wizard go to the upper menu. Select Preferences and choose Wizard.

Customize the content of your ScreenPlay to the specific appliances that you utilize in your office. You can easily reduce the amount of appliances you want to appear. The new Wizard allows you to manage the menu options throughout ScreenPlay and it is simple to use. For example, under Class II > Crowding > Fixed Appliances, you have 16 appliance options, including Class II Correctors and Distalizers. That makes for a confusing menu. You can choose to activate only the only appliances you use, perhaps a single or two different Class II Correctors.

Note: You can go to Wizard at any time and select to activate/deactivate appliances.

New User Installation Wizard

All Solutions by Design clients will have an ANDI® account set up for them. We do this internally for all new clients as well as all existing clients.

ANDI is a web-based management center and is where you manage and access all of the content for each of your SBD products. Whether it is ScreenPlay Pro, or other applications such as ScreenPlay Montage® or bLink®, you can manage your own preferences and settings, as well as download updates from ANDI.

Note: New users will receive an automated email with a link and login credentials to ANDI.
Log into ANDI where you will be asked to complete the ScreenPlay Wizard. The Wizard allows you to set up ScreenPlay the way you want to use it. Deactivate animations and videos that do not correlate to the way you practice. ie, if you are not a Damon user and do not want to include Damon animations, the wizard will delete them from your copy of ScreenPlay. This makes for a cleaner and more user-friendly experience.

As you complete the wizard you will be shown a proof of the licensing imprint that will be permanently applied to all of the animations and videos in ScreenPlay.

**Menu Options**
The menu at the top of the screen allows you to manage ScreenPlay and its contents at a glance. Most of the functionality located in the menu bar is also accessible from buttons within ScreenPlay.

**Top Menu**
Top Menu options

**ScreenPlay** > **Quit** – Exit ScreenPlay.

**File** > **New** – Start a new presentation.

- **Protocols** – Activates the Protocol Manager section.
- **Presentation** – Brings you to the Upload Center. This is where you can upload or burn a CD of your patient’s case presentation.
- **Import Records** – Allows you to manually import patient records if you have not activated your management software integration. A box with a “browse” feature will allow you to navigate to the desired files on your PC, MAC or server. You can select one or several records at the same time. Once selected, each imported image will upload as thumbnails at the bottom of the main screen. Simply click on each of the thumbnails and the image will appear on the right display screen.

**Edit** > Allows you to edit the Forms and Clinical Findings document. Simply follow the prompts to make changes as selected.

**Preferences** > Activates the setup **Wizard** and **Settings** section.

**Language** > ScreenPlay comes in five different languages. Currently, we support **English, French, Spanish, Dutch and Polish**.

**Format** > Toggles between **Mixed** or **Permanent Dentition** menu on the Malocclusion toolbar.

**Help** > Download a PDF copy of this manual or link to our support center.

FUNCTIONALITY

Languages

The language section is a great feature for bilingual practices. ScreenPlay Pro offers English, French, Spanish, Dutch and Polish. We are currently editing, proofing and working with our expert translators to complete the audio tracks.

<table>
<thead>
<tr>
<th>Buttons/Menus</th>
<th>English</th>
<th>French</th>
<th>Spanish</th>
<th>Dutch</th>
<th>Polish</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Forms</th>
<th>English</th>
<th>French</th>
<th>Spanish</th>
<th>Dutch</th>
<th>Polish</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Voiceovers</th>
<th>English</th>
<th>French</th>
<th>Spanish</th>
<th>Dutch</th>
<th>Polish</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>x</td>
<td>8.1</td>
<td>8.1</td>
<td>8.2</td>
<td>-</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Caption Copy</th>
<th>English</th>
<th>French</th>
<th>Spanish</th>
<th>Dutch</th>
<th>Polish</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>x</td>
<td>8.1</td>
<td>8.1</td>
<td>8.2</td>
<td>-</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mini Videos</th>
<th>English</th>
<th>French</th>
<th>Spanish</th>
<th>Dutch</th>
<th>Polish</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>x</td>
<td>Partial</td>
<td>8.1</td>
<td>8.2</td>
<td>-</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>MiniVideo Caption Copy</th>
<th>English</th>
<th>French</th>
<th>Spanish</th>
<th>Dutch</th>
<th>Polish</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>x</td>
<td>Partial</td>
<td>8.1</td>
<td>8.2</td>
<td>-</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Video Clips</th>
<th>English</th>
<th>French</th>
<th>Spanish</th>
<th>Dutch</th>
<th>Polish</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>x</td>
<td>8.1</td>
<td>8.1</td>
<td>8.2</td>
<td>-</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Video Clips Caption Copy</th>
<th>English</th>
<th>French</th>
<th>Spanish</th>
<th>Dutch</th>
<th>Polish</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>x</td>
<td>8.1</td>
<td>8.1</td>
<td>8.2</td>
<td>-</td>
</tr>
</tbody>
</table>
Optional Practice Custom Backgrounds (For email and CD presentations)

Indicate whether or not to include your customized background image as the first image in your presentation. This is the same image that displays in the dual main screens on the main page when you first start ScreenPlay. A custom background screen is made for you when you purchase ScreenPlay.

Web-based Administration

ScreenPlay automatically stores all of your patient’s emailed presentations on our FTP site so it will not be necessary for you to store them on your hard drive for future reference. It is easy to access, resend, delete or change.

To do this, go to:
http://www.andisolutions.com

You can use your ANDI user name and password to access this site.

Sample of presentation emailed to your patient. Videos, animations, forms and clinical findings are included.

Note:
A link will be emailed to your patient. They will enter their Username and Password provided in the email to access their presentation online.

Includes: Clinical findings, recommendations, actual patient records, problem animations, treatment animations, videos and office and clinical forms.
Protocol Management Center (PMC)

With Protocols, you can create a “favorite” set of animations. It may be just a single animation like an RPE, or an entire string of animations and videos. This provides simple access for individual appliances or problems.

With the PMC you can:
- Edit the Content of Existing Protocols
- Rearrange the Order that Protocols Appear in the list Displayed
- Delete an Existing Protocol
- Rename Existing Protocols
- Create New Protocols
- Play a Protocol (Features a Play All option!)

The Protocol Management Center is located in the left display screen. Click on the PROTOCOL button to activate the center. The screen will slide vertically. If you have preset protocols from 7.0 you will see those listed on the left side of the screen.

This procedure will place the popular RPE device with an acrylic retainer to ensure proper molar growth and healthy upper jaw expansion.

This is the Staging Area. Notice that once you select a Protocol from the list, by clicking on any one of the listed Protocols, thumbnails will appear in the Staging Area. These thumbnails represent each of the animations or videos saved in that Protocol.
Editing the Content of Existing Protocols

Click on the PROTOCOLS button located above the left display screen. A list of your existing Protocols will appear.

Click on any of those listed. You will see the thumbnails representing each of the animations and/or video clips associated with that Protocol. Slide to the right or left to view all content for each Protocol. (Oftentimes users don’t notice that there is more content, i.e. additional animations to the right.)

Click on the Edit button to add or delete content from an existing Protocol or to rearrange the order of animations within a Protocol.

Sample Protocols

**CLASS II DIV 2**
- Record Process Video
- Extraoral Animation
- Intraoral Animation
- Braces L-A-R Animation
- Aligners L-A-R Animation
- Herbst Animation
- Hawley Upper Animation
- Lower Bonded 3x3 Animation

**CLASS I Spacing**
- Record Process Video
- Extraoral Animation
- Intra-oral Animation
- Braces L-A-R Animation
- Aligners L-A-R Animation
- Hawley Upper Animation
- Removable Retainer Full Length Video

**CLASS I Spacing**
- Braces Video
- Extraoral Animation
- Intra-oral Animation
- Braces L-A-R Animation
- Aligners L-A-R Animation
- Soft Tissue Laser Contouring Animation
- Hawley Upper Animation

To add new content to an existing Protocol, go to the Malocclusion menu, select the content to fill the Staging Area. Drag and drop or click and that animation will load. Once edits and additions are complete, CLICK on the SAVE button.
Rearranging the Vertical Order that Protocols Appear in the List Displayed

To rearrange the vertical order of the list of Protocols, simply click on the desired Protocol on the list. It will turn to white. Hold it with the mouse and drag it up or down to the desired location and release.

You do not need to be in the “Edit” mode to rearrange the order that Protocols appear.

Note:
You will see a SAVED notice indicating that the change has been made.

Deleting Protocols

1) Select the desired Protocol by clicking on it in the list of Protocols.

2) Click on the Delete button. You will be asked to confirm that you do indeed want to delete the Protocol.

Note:
Exit Protocols by clicking on the arrow to the right of the Protocols Button.
Rearranging the Horizontal Order Content as it Appears in a Protocol

Go to the Malocclusion or Video menu to select the content to fill your Protocols. Navigate to any animation or any video clip within ScreenPlay. Click on that button and that thumbnail will appear in the lower portion of the Protocol Management Center.

Drag the thumbnail left or right to rearrange the order/sequence of the animations.

Creating New Protocols/Reset Button

To create additional/more Protocols, drag new animations to the Protocol horizontal bar then click the Save.

Name the animation then hit Save again. Your new Protocol will now appear on the list.

Renaming Existing Protocols

Select desired Protocol. Click on the Edit button and you will see the name and description. Change the name and edit the description. Click Save.

Note:
You can grab and slide the Protocol list to achieve any order as you place thumbnails to build your Protocols.

We suggest that you grab a pad and pen and make a list of desired Protocols and list the content desired to the right of each. This will make the creation process easier and more complete.
Playing a Protocol (Now features a Play All option)

ScreenPlay 8.0 records the animations that you have presented to a patient. By clicking on the light "blue bar”, you will see the thumbnails for each presented animation or video. This allows you to go back to a previous series of animations or video clips at any time without going through the malocclusion menu.

1) Click on the PROTOCOLS button
2) From the vertical list that appears, select which Protocol you want to play. It will turn to white.
3) To manually play each animation or video in a Protocol, use the FORWARD or BACK arrows.
4) Click Play All to play each of the animations or videos in sequence or the Next button to manually play each one at a time.

Presentation History

Q: Will my existing Protocols still be active after installing the upgrade?

Ans: A: Yes, all of your existing protocols will still be intact. Bundled with your Screenplay application is another app called the 'SP7Upgrade'. Open this app on any computer currently housing a Screenplay 7.0 install and follow the on-screen directions. Once used, it will grab your old protocols and convert them for use in Screenplay 8.0 without you having to do anything else.

We suggest that you replace some of the previous 2D animations with the new 3D animations.
Videos and Forms

Videos

To select and play a Full Length Video or a Video Clip, click on the Video button. There you will see a list of videos available.

---

Forms

To activate the form section, CLICK on Go to Forms button located in the bottom left corner of the main screen.

Forms are now easier to edit and rearrange in the order that they appear in the forms list. You can also deactivate any forms you do not use.

---

Note:

In your Wizard you were asked to deactivate any videos (Full Length or Clips) not necessary to the way you practice. If you have deactivated a video and you want to reactivate it, go to the Wizard and reactivate as desired.

- Full length videos range from 3-6 minutes.
- Video clips are condensed versions of the full length videos lasting less than a minute.

---

Note:

Turn ON/OFF any forms that apply or don’t apply to your office.
Clinical Findings Form

The Clinical Findings form compiles patient records, animations, patient data and recommendations.

To activate the Clinical Findings form, click Go to Clinical Findings button located on the lower right-hand portion of the main screen.

Added features

- Modify Existing “Standard Recommendations”
- Create New “Standard Recommendations”
- Create “One-off Recommendations” for Individual Patients
- Repositioning of Thumbnails for Problems and Treatments and Imported Records in the Body of the Form
- Design your own Form Layout

Modifying an Existing “Standard Recommendations”

By selecting the Create (+) button in the Recommendations area, you can change the stock descriptions provided for each Recommendation. Simply click on the button to view each. There you can edit and save as desired.
Creating New Standard Recommendations

In the same area as above you can create new and or additional Standard Recommendations as desired.

Click the CREATE button then select Add. Enter and save your new standards.

Repositioning of Thumbnails for Problems and Treatments and Records

To reposition or re-organize any of the problem, treatment or record images as they appear in the clinical findings document, simply click on the arrow handles and grab the desired image/s and move it to the intended position.

Note:
We have enhanced the thumbnails representing the Problems and Treatment animations and videos to be more consistent with the actual problem, treatment option or appliance.
**Player Scrub Bar/Audio and Caption Copy**

The new ScreenPlay **Scrub Bar** allows you to:

- Control the animation presentation by manually sliding the bar forward and backwards
- Pause, restart and reverse an animation
- Play an animation with a voice over
- Control the volume of the voice over
- Play an animation with caption copy activated

Captions appear for each animation when **Caption button** is activated.

**Note:**

For ScreenPlay Montage users, the new voice and caption features are now available on your Montage displays. To activate them go to your ANDI login and activate the voice over and or caption features.

**Montage board**

ScreenPlay Montage is an interactive patient education system that is presented via a 42” touch-sensitive monitor that resides in the reception area of your practice. We utilize many of the animations and videos in ScreenPlay so patients can touch and play educational content specific to their case as desired. Montage also plays manufacture videos for Invisalign, Damon, SureSmile and AOA Labs.
GETTING STARTED

ScreenPlay’s design allows easy access and management of display files. Accessing and activating display files is simple and convenient. Features such as our “drag-and-drop” technology allow the user to drag images to either of the two main screens for display and management. You can also select an animation and click it to load to the left display screen.

ScreenPlay is comprised of a dual main screen, three functional presentation screens and four secondary utility screens:

From the main menu, select the desired language. The program will instantly be presented in that language. The default language is English and can be changed in the Wizard.
The following describes how ScreenPlay can most effectively and efficiently be utilized in an orthodontic office:

**Step 1: Patient Introduction Movie**

You have the option of activating an 8-minute multimedia patient presentation as a first step in the initial patient examination. Activate the video by selecting the intro video located within the video library. This is a good time for the presenter to leave the exam room and attend to other responsibilities.

The introduction walks the patient through the typical orthodontic experience from records to retention. Now your patient knows what to expect and is prepared to proceed to records.

**Step 2: Records Exported to ScreenPlay from Your Management and Imaging Software**

Patient Records can be passed to Screenplay from your management software. See the integration guides on our website, [www.solutionsbydesign.com](http://www.solutionsbydesign.com) or on the website of your developer. Several of the Practice Management Software applications will:

a) Pass actual Patient Records.

b) Activate a string of animations and videos (Protocols, see page 5) based on the patients problem and your treatment recommendation.

c) Pass Patient Data such as name, address, email address, etc.

The Protocol will load in the left display screen and the actual Patient Records will load in the right display screen.

**Note:**
The patient records thumbnails will appear in the “Imported Records Toolbar”.

ScreenPlay Pro 8.0 Manual 16
Step 2a

Notice that once you either click to load or drag any thumbnail to the display screen or screens, the animation is in a "Staging Area". This allows you to drag multiple animations to the display screen and then Play All or click on each one at a time to play each.

The “Staging Area” slides to a hidden state once you activate an animation. To make the staging area reappear simply hover your mouse over the lower portion of the display screen.

Hint: As you become more familiar with ScreenPlay, you will be able to create or modify your Protocols to sync with the Patient Records sequence. ie. Extraoral patient photo appears in the left screen, ExtraOral animation plays in the left, Intraoral patient photo appears in the right followed by a ScreenPlay IntraOral in the right, etc.

Step 2b

To import actual patient records, go to the menu at the bottom of the screen. When you click the Import button, a window and menu will appear to access files from your computer. Select the files desired and click OK. A thumbnail will appear in the bottom toolbar. Simply click on or drag this thumbnail to either display screen.

Note: Be sure to select JPG files.
Step 3: Patient Case Presentation

At the point that records are completed, the doctor can proceed with an evaluation. Upon completion of his or her examination, the doctor indicates the problem and likely, the treatment plan. The balance of the presentation is typically conducted by the treatment coordinator.

You will notice that there are two primary toolbars in the main menu of ScreenPlay:

![ScreenPlay interface with toolbars highlighted](image)

Step 4: Choosing the Proper Patient Age Classification and Malocclusion (referred to in ScreenPlay as Patient Classification)

Each orthodontic case presented in ScreenPlay is specific to a patient’s age classification. To present a specific case, first select either Mixed or Permanent dentition from the button located above the patient problems toolbar. The age classification will automatically load in the Problem and Treatment toolbars. Select the desired classification and click on the desired demonstration file specific to this malocclusion.

![Patient Classification toolbar with options](image)
For example, by selecting Permanent Dentition, Class II, Division 2 in the classification toolbar, you have automatically loaded all the case presentation files in these toolbars with files specific to Permanent Dentition Class II Div2 cases.

Step 5: Patient Problems

Once you have chosen the specific age classification and have selected the desired malocclusion, proceed to the Problems toolbar. Here, you have a choice of several different display modes including ExtraOral or IntraOral.

For example, to display problems in the ExtraOral mode, click on the ExtraOral button. A pop-up menu will appear with the different perspective options (typically 3D). Click and HOLD the perspective button while you drag that image from the toolbar to either of the two display screens. This is our “drag-and-drop” technology. Clicking on that animation will automatically load it to the left screen.

Problem files include:

a) ExtraOral
3D facial animations and sliders. Utilized for two patient age classifications: Mixed Dentition and Permanent Dentition.

b) IntraOral
3D animations that start in the specific malocclusion state and animate to the local state.
Step 6: Treatment Toolbar

The Treatment Toolbar operates exactly like the Problems Toolbar. The following is a brief description of each Treatment display mode.

### Treatment Solutions Toolbar

**Note:** Appliances with multiple-step functionality are presented and accessed in sequence in the pop-up menu. Each step is activated by clicking on the buttons and dragging the thumbnail.

#### a) Braces/Aligners
Each orthodontic problem that can be treated with braces is presented with braces and aligners for some permanent dentition cases. Each case morphs from the state of malocclusion to the projected treatment results.

**Note:** We have included branded Invisalign® and Insignia® Clear Guide options.

#### b) TADS
Various TADS clinical animations are located under the appropriate malocclusion.

#### c) Removable Appliances
Removable appliances are located under their corresponding menu button. A morph displays in each case. The perspective is based on that which best represents that particular case.

#### d) Fixed Appliances
Fixed appliances are also located under their corresponding menu button.

#### e) Orthognathic Surgery
Surgical case animations display the action that will take place in surgery. High-quality photographs and illustrations show sections of the jaw and the repositioning of the jaw to the targeted position. Drag the thumbnail to either display screen.

#### f) Extractions
Extraction animations are represented from an occlusal and lateral perspective. The intended tooth or teeth are dissolved, followed by the movement of the remaining teeth into the corrected position. Drag the thumbnail to either display screen.

*We are creating a dynamic 3D library for all extraction cases. These will be updated as completed.*
Step 7: Clinical Findings Report

To access the Clinical Findings report, click the Go to Clinical Findings at the bottom right of the screen. Your Clinical Findings can be recorded and presented to the patient as part of your email linked presentation, burned to a CD or printed as part of your “walk-out” package. This is typically used at the conclusion of the exam.

Enter the patient’s info, key in a description of your findings, select the desired treatment recommendation and enter any notes.

You can print this document or go to the Menu and select Upload to email the presentation.

Save form as PDF will allow you to save a form for attachment to your PMS. Tops currently features a “iCorrespondence” utility that attaches and saves the form to the patient’s charts. The PDF function is ideal for GP communications as well.

Note:
If you have synced ScreenPlay with your Management Software, your patient’s information will automatically fill in.
Step 8: Selecting Patient Information and Care & Use Forms

Because this section has been customized for your practice, the information on Policies, Procedures and Care & Use are all specific to the way you practice. Simply click on any of the individual information sets that you desire, or select all. Each can be printed, included in your online presentation or included on a CD with the balance of your presentation.

Note:
Once you select items from the list, this tells ScreenPlay to:
1) Put them on the printable forms.
2) Include these in the patient email or CD presentation.

Referral Communications:
Located in the lowest section of the Videos and Forms page are the referral communications features. Simply select one of the two extractions forms, complete the form and e-mail it to your oral surgeon or dentist.

(Currently being revised into this 3D, dynamic display.)
Step 9: Upload and Email

The presentation captured in the Image Recorder, the selected Patient Information forms and Clinical Findings can be emailed to the patient.

To do this, simply go to the Main Menu, click File, then Upload. Select what information you would like to send by clicking on each box on the left-hand portion of your screen. Key in the patient name and email info then click Upload.

Online presentation sample

Includes: Clinical findings, recommendations, actual patient records, problem animations, treatment animations, videos and office and clinical forms.

Marketing Tip:
 Ask how your case presentation can be sent to your patients with a link to a login page on your website.
ADDITIONAL FUNCTIONALITY AND FEATURES

Two-phase Treatment

Located on the Mixed Dentition Patient Classification toolbar, you will notice the Phase II button. Select this button and you will see two options in the dropdown menu... “Extractions” and “All Other Appliances”. Extractions include all second phase treatment options involving extractions. For example, Phase II, 4/(extracted upper first premolars) starts with the upper 4’s removed and demonstrates the eruption of permanent teeth followed by braces to finish the case. Braces with space maintainers options are allocated here.

Multiple Perspectives

Demonstration files feature multiple perspectives.
Multi-Function Appliances

Functional appliances, such as a Sagittal TwinBlock, provide several purposes. Class II Correction, Super-imposed Pallet Expansion, Secondary Molar Eruption and Primary Molar Eruption. You will notice that each step or function is demonstrated one by one. This allows for a very detailed and thorough presentation.

Multiple Treatment Options

Case problem demonstrations, such as Class II Div 2, offer multiple demonstrations. For example, under the Braces, there is a dropdown menu offering 2x6, Uppers and Full Braces as treatment options. The user can select from these options.

Multi-Step Treatment

Use protocols to create the desired series of images.

Blue Arrows

In some cases where the number of buttons/thumbnails exceeds the right-to-left dimension of the screen, a blue arrow will be activated on the sides of toolbar. You can navigate the other thumbnails by clicking on the left or right arrows.

System for a New Patient

On the Menu, under FILE, select NEW. If you notice that the buttons do not function correctly or the program stalls, this usually indicates that the system cache is full. It is important to periodically clear the system cache by exiting and restarting ScreenPlay.
**Aesthetic Braces, Retainers, Non-compliance Images**

We have chosen Class I, Aesthetics Retent & Utilities as a location for your utility display files. Located under EACH Mixed Dentition and Permanent Dentition, Class I, Aesthetics Retent & Utilities are:

- Aesthetic Braces
- Retainers
- Relapse/Non-compliance

**Braces Options**

Also in Class I, Aesthetics Retent & Utilities are the display files for different types of braces such as Damon, Lingual and In-Ovation.

**Retention Images**

Retention appliances are located under Class I, Aesthetics Retent & Utilities of each patient classification. Retention appliances are divided into four types:

- Hawley Retainers
- Positioners
- Bonded Retainers
- Clear Retainers

**Dental Development**

The demonstration displays teeth growth from age 9 to age 14.
**Updating ScreenPlay**

Notice that each time you launch ScreenPlay, a small dialogue box appears indicating that ScreenPlay is checking for authorization updates. If the updates have been pushed out by our team, you will see a message asking if you want to update now or later. If you are in the middle of a patient presentation, you may want to update later. Updates generally only take a minute, however a major update may take longer.

### Versioning

**How do you know what has been included in your update?**

You can check our website at www.solutionsbydesign.com by clicking on the **ScreenPlay Updates & Patch Notes** button under the **DOWNLOADS** tab to see what’s new and what is in the works.

**What the numbers indicate:**

`8.1.2`

- `8` is the Annual Version number
- `1` represents new application features
- `2` means that there is new content, such as new or revised animations, videos, etc.

### Global Mute and All Play timing settings

Global muting and caption copy deactivation, as well as All Play timing settings are now available in the **Preferences** tab under **SETTINGS** on the upper menu.

Muting allows you to turn off all voice over audios for all animations.
Support

The new support feature allows each user to create and submit any requests for support from the application. If you need additional training, would like to request an additional animation, additional video content, or have a question on functionality, you can complete a support ticket and submit it to us instantly.

Saving Images in your Protocols

Now any image you import into ScreenPlay can be saved into a Protocol. Simply add your imported image to the selected Protocol and save.
To add actual patient records into a protocol you can either:

(A) Import the image into the lower toolbar, then drag it to the left screen when in the Protocol mode. Then Save.
- or -

(B) Push patient records to ScreenPlay from your management software you can follow the same path. Drag each to the left screen while in protocol creation mode.

New video content

View all videos and video clips by clicking on the VIDEO button in the top center of your screen. We have added a 12 Steps Video which compiles the 12 individual animations into one seamless video. We have also added a new Introduction Video that excludes descriptions on elastic ties, as well as a new Emergencies Video that excludes descriptions on headgear.

About ScreenPlay

Located in the HELP tab, under ABOUT on the upper menu, this feature allows you to verify which version of ScreenPlay you are running.